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Installation Overview  

Preventive Controls Governor (PCG) is a set of applications that run within Oracle 

E-Business Suite. These applications include: 

• Form Rules, which modifies the security, navigation, field, and data properties 

of Oracle EBS forms. 

• Flow Rules, which defines and implements business processes.  

• Audit Rules, which tracks changes to the values of fields in database tables that 

underlie Oracle EBS.  

• Change Control, which regulates changes to the values of fields in Oracle EBS 

forms. It can monitor change, require a reason for a change, or require approval 

for a change.  

In the background, PCG also provides “User Provisioning” functionality employed 

by a separately installed product, Application Access Controls Governor.  

PCG can display information in any of thirteen languages: US English, traditional 

Chinese, standard (simplified) Chinese, Danish, Dutch, French, French-Canadian, 

German, Italian, Japanese, Korean, Brazilian Portuguese, or Spanish.  

You can install version 7.3.4, or upgrade to it from the previous version. The 

installation (or upgrade) procedure accommodates all thirteen languages.  

PCG components are installed on the forms and concurrent manager servers on which 

Oracle EBS runs. The installation process implements the following architecture: 

• Database Schema: Installation requires the identification of a schema for use by 

PCG applications. You’re strongly advised to use a dedicated schema named 

XXLAAPPS. However, you may use a schema that has already been established 

for third-party products. 

• Tablespace: You’re advised to create a tablespace for indexes used by PCG data-

base objects. (An already established tablespace may be used.)  

• Database Objects: PCG makes use of database tables, packages, sequences, and 

workflows, which are placed in the XXLAAPPS (or user-specified) schema.  

• Application Server Objects: PCG uses custom forms, which are installed on the 

application server. Custom forms are located in language-specific subdirectories 

of the $XXLAAPPS_TOP/forms directory.  
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• Program Executables: PCG uses program executables to report on, migrate, and 

compile business rules. Reports, programs, and Java files are installed on the con-

current manager server (typically the database server). Custom programs are 

located in language-specific subdirectories of the $XXLAAPPS_TOP/forms directory; 

some executable programs may also reside in the $XXLAAPPS_TOP/bin directory. 

Two comprehensive Installer programs place PCG applications on the concurrent 

manager server and forms server — either for a fresh installation or for an upgrade 

from the earlier version. (They also install a rules engine that provides functionality 

to the applications.) Each Installer may be run in any of three modes: 

• GUI: The Installer programs present a series of windows that prompt for infor-

mation necessary for the installation. Each window also provides access to a 

help window. As you progress through the windows, you can return to windows 

you had completed earlier in order to review or change the entries in them. (The 

Installers retain any entry you don’t change, even if you return to a step earlier 

than the one in which such an entry was made.) GUI mode is the default.  

• Console: The Installer programs present a series of prompts in a command con-

sole. In response, you provide information necessary for the installation. Console 

mode prompts for the same information as GUI mode, but does not enable you 

to return to earlier prompts and does not provide help screens.  

• Silent: The Installer programs read parameters from properties files, and then 

run without user interaction. 

Preparatory Procedures 

Before installing Preventive Controls Governor, ensure the following: 

• Grant the following APPS schema objects the execute privilege to the PCG 

schema: 

– FND_FILE — Package Spec and Body 

– FND_PROFILE — Package Spec and Body 

• Download and install Java Runtime Environment (JRE) 1.7.x (if it does not 

exist already in your operating system). Having done so, set the JAVA_HOME 

environment variable to the location in which you have installed JRE 1.7.x. 

Then add $JAVA_HOME/jre/bin to your environment variable path. 

• Each of your database server, forms server, and concurrent manager server may 

run on its own host machine. If so, complete the following tasks to confirm that 

the host machines communicate properly: 

– Send a file via FTP from the database server to the concurrent manager 

server, and from the concurrent manager server to the forms server. 

– Perform a remote execution of the shell file, by any of the following 

methods: Enable rsh (remote shell), enable ssh (secured shell), have a 

common mount point, manual. 
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Sizing Considerations 
Make sure your forms server has 100 megabytes (MB) of disk space for PCG files, 

and the concurrent manager server has 100 MB of disk space for PCG  executable files.  

Moreover, the PCG schema requires the following amounts of disk space: 

• 100 MB for most PCG database tables.  

• An additional 1 gigabyte (GB) for two temp tables used in Audit Rules 

processing — LAAD_AUDIT_KEYS and LAAD_AUDIT_VALUES. 

The GRC Controls schema (XXLAAPPS or user-specified) requires space to encompass 

shadow tables used by Audit Rules — one-third the space taken by each audited table. 

Software Requirements 
Each instance of Preventive Control Governor runs with an instance of Oracle E-

Business Suite. Certified versions of EBS are identified on the GRC Suite Certifica-

tion Matrix, Doc ID 741001.1 on My Oracle Support. 

Oracle Linux 7 is the certified operating system for PCG. Some other operating 

systems are supported, meaning that they should run PCG, but have not been tested. 

Complications may arise, and if so you may require additional assistance. Windows 

operating systems are not supported. 

Each PCG 7.3.4 instance requires an Oracle 12.2.0.3 database, also known as 19c.  

Obtain Installation Files 
The PCG 7.3.4 application is available from the Oracle Software Delivery Cloud. 

1. In a web browser, navigate to edelivery.oracle.com. Sign in (or create an 

account). 

2. Search for Oracle Preventive Controls Governor. Among the search results, 

click the Oracle Preventive Controls link to add the installation file to your 

download queue. Click Continue. 

3. In a second page, select Linux x86-64 in the Platforms/Languages field of the 

row for Preventive Controls Governor. Click Continue. 

4. In a third page, click the check box that confirms you accept the Oracle License 

Agreement. Click Continue. 

5. In a fourth page, review your selections and click Download. 

For any given release of Preventive Controls Governor, you may need to install 

patches. If so, they are identified in the Release Notes for that release, and you can 

download them from My Oracle Support. Instructions for installing each patch are 

provided in a readme file that accompanies its download. 
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Prepare Properties Files 
If you intend to run the Installer programs in silent mode, you need first to edit the 

two properties files you extracted, inserting information specific to your installation. 

(If you intend to use GUI or console mode, you don’t need the properties files, and 

you can ignore this section.) 

To insert values in the files, use a text editor. Each file consists of a series of name-

value statements, each of which sets a parameter name equal to a value and each of 

which is preceded by an explanatory comment. (Each comment begins with a # 

symbol.) In each statement, edit information to the right of an equals sign; don’t 

(with one exception, discussed below) modify text to the left of the equals sign.  

Insert into the files exactly the same information as you would supply in response to 

prompts if you were to run the Installers in GUI mode. For detailed descriptions of 

that information, see Chapter 2, “Install Preventive Controls Governor.”  

The two properties files — ladbinstall.properties (concurrent manager) and 

lafrminstall.properties (forms) — share many parameters, which correspond as 

follows to the GUI prompts discussed in Chapter 2: 

• CUST_NAME and LICENSE_KEY: Prompts in the License Key window, step 1 on 

page 10 (concurrent manager), or step 1 on page 14 (forms). 

• #STAGE_DIR: Prompt in the Staging window, step 2 on page 10 (concurrent 

manager), or step 2 on page 15 (forms).  

This statement is the exception to the rule that you should leave parameter names 

intact. In the assumption you will want the Installers to set default staging 

directories, this statement is commented out in the properties file. To use the 

statement, you must not only supply a staging directory path to the right of the 

equals sign, but also delete the # symbol at the beginning of the statement. 

• DB_HOST_NAME, DB_SID, and DB_PORT: Prompts in the Database Host window, 

step 3 on page 11 (concurrent manager), or step 3 on page 15 (forms). 

• DB_XXLAAPPS_SCHEMA_NAME, DB_XXLAAPPS_PASS, DB_APPS_SCHEMA_NAME, 

and DB_APPS_PASS: Prompts in the Database Schema window, step 4 on page 

11 (concurrent manager), or step 4 on page 15 (forms).  

Another exception: The concurrent-manager-installation window does not 

prompt for the Oracle EBS schema name, although the forms-installation win-

dow does. The properties file requires it (typically APPS) as the value for the 

DB_APPS_SCHEMA_NAME parameter. 

• XXLAAPPS_SHORT_NAME and APPL_TOP: Prompts in the Application TOP win-

dow, step 5 on page 12 (concurrent manager), or step 5 on page 15 (forms). 

• ENVFILE and ADOVARS: Prompts in the Environment window, step 6 on page  

13 (concurrent manager), or step 6 on page 16 (forms). 

The ladbinstall.properties file contains one parameter — INDEX_TABLESPACE — 

that does not appear in lafrminstall.properties. This parameter corresponds to the 

Index Table Space prompt in step 4 on page 11. 
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The lafrminstall.properties file contains two parameters that don’t appear in the 

ladbinstall.properties file. These two parameters correspond as follows to the GUI 

prompts discussed in Chapter 2: 

• APPSORA: The final prompt in the Environment window, step 6 on page 16. 

• CUSTOM_CHOICE: The prompt in the CUSTOM.pll window, step 7 on page 16. In 

the properties file, any value other than No (case-sensitive) is equivalent to Yes.  

Finally, both files contain a parameter that does not correspond to any GUI prompt. 

For you to run the Installers in silent mode, an INSTALLER_UI parameter must be set 

to the value silent. This is the default; don’t change it. 
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2 

Install Preventive Controls Governor 

In broad terms, the PCG installation or upgrade process involves four steps: 

1. Create a tablespace for PCG indexes, and a custom database user/schema. The 

user/schema name XXLAAPPS is recommended. Or, if you’re upgrading PCG, use 

the tablespace and schema created for your earlier instance.  

2. Run the Installer program to place PCG tables, packages, sequences, and work-

flows on the concurrent manager server. All the table names begin with the prefix 

LA, and all tables reside in the PCG schema (typically XXLAAPPS). The concurrent 

manager server installation must precede the forms server installation. 

3. Run the Installer program to place PCG forms on the forms server. All custom 

forms are located in language-specific subdirectories of the $XXLAAPPS_TOP/forms 

directory.  

4. Configure a remote compilation feature, which makes libraries resident on the 

concurrent server available to the forms server. 

Create a User and Tablespace 
If you’re performing a new installation of PCG 7.3.4, create the PCG tablespace and 

database user/schema. The latter must be granted the connect and resource privileges 

in the Oracle EBS database. You’re strongly advised to use the name XXLAAPPS for 

the new user, and to create all PCG database objects in the XXLAAPPS schema. 

Execute the following before you create the schema. Connect to the CDB (container 

database) and change the session to PDB (pluggable database): 

$ sqlplus/nolog 

SQL> connect / as sysdba 

SQL> show pdbs 

CON_ID    CON_NAME    OPEN MODE     RESTRICTED 

------    --------    ---------     ----------  

2         PDB$SEED    READ ONLY     NO 

3         ebsdb       READ WRITE    NO 

SQL> alter session set container="ebsdb"; 

SQL> show user; 

SYS 
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The following is a sample SQL script that can be used to create the user: 

CREATE USER XXLAAPPS 

IDENTIFIED BY XXLAAPPS 

DEFAULT TABLESPACE &DEF_TSPACE 

TEMPORARY TABLESPACE &TMP_TSPACE 

QUOTA UNLIMITED ON &DEF_TSPACE 

QUOTA 0K ON SYSTEM 

ENABLE EDITIONS; 

GRANT CONNECT TO XXLAAPPS; 

GRANT RESOURCE TO XXLAAPPS; 

GRANT SELECT ON GV$INSTANCE TO APPS; 

GRANT SELECT ON ALL_OBJECTS TO XXLAAPPS WITH GRANT OPTION;  

GRANT SELECT ON DBA_OBJECTS TO XXLAAPPS; 

GRANT SELECT ON ALL_TABLES TO XXLAAPPS; 

GRANT SELECT ON ALL_VIEWS TO XXLAAPPS; 

GRANT CREATE VIEW TO XXLAAPPS;  

Connect to the pluggable database with user APPS and execute these comands: 

GRANT EXECUTE ON FND_FILE TO XXLAAPPS; 

GRANT EXECUTE ON FND_PROFILE TO XXLAAPPS; 

Allocate a minimum of 80 MB of space, 40 on the tmp directory and 40 on the file 

system from which the installer is to be launched. 

If you’re upgrading PCG, you’re assumed first to have upgraded your database to 

19c. As part of that operation, the 19c database inherited the PCG tablespace and 

schema from the previous database version. Determine the name of the PCG table-

space, and the name and password for the PCG schema, as you will need to supply 

these during the upgrade. As part of the upgrade, execute all the grant statements 

shown above. Before upgrading, take a backup of your PCG schema.  

Prepare for Installation 
Complete the following steps before running the installation programs.  

1. Execute the environment file, if it is not included in the profile: 

$. $APPL_TOP/$APPLFENV 

2. At the operating-system command prompt, use the make-directory command to 

create a custom application top (the high-level directory for PCG file storage).  

Its form must be the full path to the Oracle APPL_TOP; then, as a subdirectory, 

the PCG database user name; and finally, as a subdirectory at the next level, the 

value 12.x.x. For example, if the Oracle APPL_TOP were /oracle/bin/ebiz12/appl, 

the PCG  database user name were XXLAAPPS, and the Oracle EBS release were 

12.2.9, the following command would create the custom application top: 

mkdir /oracle/bin/ebiz12/appl/xxlaapps/12.2.9 

3. Export the custom application top path in the environment file (which is named 

for the database SID and host name, with a .env extension, and is located in the 

Oracle APPL_TOP directory). If the path in step 2 were the custom top, the 

environment-file entry would look like this: 

XXLAAPPS_TOP="/oracle/bin/ebiz12/appl/xxlaapps/12.2.9" 

export XXLAAPPS_TOP 
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4.  In the directory $APPL_TOP/admin, locate topfile.txt; open it for editing. Add an 

entry that sets the relationship of the Embedded-Agent-database-user-name sub-

directory to the APPL_TOP directory. In the current example: 

xxlaapps    /oracle/bin/ebiz12/appl/ 

5. In the directory $APPL_TOP/admin, create the file applcust.txt. Open it for 

editing, and insert the same entry as you did in step 4. 

6. Navigate to the $ADMIN_SCRIPTS_HOME directory and, from it, run three scripts. 

Each prompts for the APPS password or the APPS username and password.  

• adstpall.sh 

• adautocfg.sh 

• adstrtal.sh 

Install Concurrent Manager Server Components 
To install PCG components on the concurrent manager server (or upgrade them 

from the previous version), run the file ladbinstall.bin. (Although the Installer dis-

plays windows labeled “GRC Controls Database Install,” it actually places files on 

the concurrent manager server.) 

1. Transfer the ladbinstall.bin file to the concurrent manager server, via FTP in 

binary mode. Use the applmgr account. 

2. Use applmgr to log in to the concurrent manager server. Ensure that the user 

(login ID) has write and read privileges on $APPL_TOP. 

3. Execute the environment file, if it is not included in the profile: 

$. $APPL_TOP/$APPLFENV 

4. Set the execute permission on ladbinstall: 

$ chmod +x ladbinstall.bin 

5. Execute ladbinstall.bin: 

• To run in GUI or console mode, ensure that ladbinstall.properties is absent 

from the directory where ladbinstall.bin resides. To run in silent mode, be 

sure that both files are in the same directory. 

• Use the name ladbinstall.bin as the command to run in GUI or silent mode. 

Add the argument -i console to run in console mode. 

All three Installer modes require the same information; GUI and console prompt for 

it, and silent reads it from files. If you choose GUI mode (as shown in the following 

procedure), you can perform these operations in each of the windows: 

• Review a brief description of the information you need to provide. 

• Click on the Help button to open a window that provides a more expansive 

description of the information you need to provide. (After you review this 

information, click on the Close button to exit the Help window.) 

• Type installation information in the labeled text boxes (or accept defaults). 

• When you complete one window, click on the Next button to move from it to 

the next window. 

• Click the Previous button if you wish to return to a window you completed earlier. 
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• Note that titles of windows you have completed appear in black along the left of 

each window; those yet to be completed are shown in grey. 

To complete the concurrent manager server installation: 

1. In the License Key window, enter Oracle as the Customer Name and the follow-

ing case-sensitive value as License Key: 6MR6457YE5RJO1C8T3JhY2xl. A mes-

sage displays the applications you can install; click the OK button to clear it.  

 

2. Specify a staging directory — a temporary location for source files: 

 

The Installer suggests a default directory; its name is a timestamp for the 

moment you perform the installation, with DB. If you wish to select another 

directory, click the Choose button and, in a Select a Folder window, navigate to 
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the directory you want. If you specify a nonexistent directory, the Installer 

creates that directory. If you navigate away from the default directory and want 

to return to it, click on the Restore Default Folder button.  

3. Verify the default values for the host name, SID (service identifier), and 

network port of the Oracle EBS database server, which the Installer takes from 

the shell environment. If the defaults are not correct, enter correct values. 

 

4. Supply log-on values for the PCG schema and Oracle (APPS) schema: 

 

If you’re upgrading, enter the values established during installation of the earlier 

release. For a fresh installation, you will have created a PCG schema and index 

tablespace (see page 7); enter the schema name (typically XXLAAPPS) in the GRC 

Controls Schema field, and the schema password and tablespace name in the 
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appropriate fields. Also supply the password for the database schema that serves 

Oracle EBS in the Oracle APPS Schema Password field. 

5. Establish the GRC Controls TOP — the high-level directory for PCG file storage.  

• In the GRC Controls Application TOP Directory Location field, specify a 

directory that is the parent of the GRC Controls TOP. By default, the 

Installer selects the Oracle EBS TOP as the parent directory. 

• In the Custom Application Short Name field, specify a short name that is 

appended to the parent directory to form the GRC Controls TOP directory. 

By default the Installer selects XXLAAPPS as the short name. 

 

These values must match the APPL_TOP and immediate subdirectory you 

configured earlier (see page 8), but not the release-level value (such as 12.2.9). 

Otherwise, if you’re upgrading, enter the values established during installation 

of the earlier release. If you’re performing a fresh installation, you may accept 

the defaults or configure other values.  

To select parent directory, click on the Choose button and, in a Select a Folder 

window, navigate to the directory you want. If you name a nonexistent directory, 

the Installer creates it. Click Restore Default to return to the default directory. 

No matter what case you use to enter values, the Installer saves the short name 

as all uppercase (and adds the uppercase _TOP to create a top shell variable), and 

the directory location as all lowercase. (However, for a reinstallation, the Installer 

does not change the case of an existing application TOP.) 

If you have selected an application short name that is already in use, the Installer 

displays a warning message when you click the Next button. To respond: 

• Click Enter Again to set a new value. 

• Click Continue to accept the duplicate application short name. This choice 

is correct if you’re upgrading PCG For a fresh installation, however, this 

option causes PCG and another application to share the name, with the risk 

that files for one application or the other might be overwritten. 
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• Click Abort to abandon the PCG installation. 

6. Specify paths to files that contain environment variables for the Oracle EBS 

shell. (The installation adds PCG-specific entries to these files.) 

 

Accept the defaults, or click a Choose button and, in a Select a Folder window, 

navigate to a directory you want. If you name a nonexistent directory, the Installer 

creates it. To return to the default directory, click the Restore Default button. 

7. Review your selections in the Input Summary form: 

 

If you determine that any entry is inappropriate, you can click on the Previous 

button until you reach the form in which you selected the entry, and change it. 

(The Installer retains any entries you don’t change, even if you pass by them as 

you return to an earlier step in the installation process.)  
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8. In the Input Summary form, the label for the button at the lower right has 

changed from Next to Install. When you’re satisfied with your selections in 

earlier forms, click on the Install button to complete the installation. 

The Installer displays error messages (if any are warranted) upon completing the 

installation of each PCG application, and displays an overall status upon completing 

the installation of all products. If the overall status is Success, the installation has 

finished with no errors.  

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or 

Fatal, depending on severity. The Installer recovers (restores the system to its state 

prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. 

For details about errors and the installation process, navigate to the directory from 

which the Installer ran and review two log files: LADB_LOG_timestamp.log and 

LADB_ERROR_timestamp.log, where timestamp is the date and time at which the 

Installer ran. 

Install Forms Server Components 

To install PCG forms server components, run the file lafrminstall.bin: 

1. If the concurrent manager and forms servers run on the same host, re-source the 

environment by opening a new shell.  

2. Transfer the lafrminstall.bin file to the forms server, via FTP in binary mode. 

Use the applmgr account.  

3. Use applmgr to log in to the forms server. Ensure that the user (login ID) has 

write and read privileges on $APPL_TOP. 

4. Execute the environment file, if it is not included in the profile: 

$. $APPL_TOP/$APPLFENV 

5. Set the execute permission on lafrminstall: 

$ chmod +x lafrminstall.bin 

6. Execute lafrminstall.bin:  

• To run in GUI or console mode, ensure that lafrminstall.properties is absent 

from the directory where lafrminstall.bin resides. To run in silent mode, be 

sure both files are in the same directory. 

• Use the name lafrminstall.bin as the command to run in GUI or silent mode. 

Add the argument -i console to run in console mode. 

Most windows (or console prompts) for the forms installation are identical to those 

for the concurrent manager installation. If you select GUI mode, you perform the 

same operations in each window as you did for the concurrent-manager-server 

Installer.  

To complete the forms server installation: 

1. In the License Key window, enter Oracle as the Customer Name and the follow-

ing case-sensitive value as License Key: 6MR6457YE5RJO1C8T3JhY2xl. (These 

are the same as the values for concurrent-manager-server installation.) A mes-

sage displays the applications you can install; click the OK button to clear it.  
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2. In the Staging form, once again select a directory for the temporary placement 

of source files. The Installer once again suggests a default — its name a time-

stamp for the moment you perform the installation, along with FRM (for forms).  

If you wish to select another directory, click on the Choose button. In a Select a 

Folder window, navigate to the directory you want. If you specify a nonexistent 

directory, the Installer creates that directory. If you navigate away from the default 

directory and want to return to it, click on the Restore Default Folder button. 

3. In the Database Host form, select the database host name used where the concur-

rent manager installation has been run, and the appropriate SID and port values. 

4. In the Database Schema window, there is no longer an Index Table Space field 

(as it would be inapplicable to forms installation), but where the concurrent-

manager-server Installer requested only a password for the Oracle EBS schema, 

the forms-server Installer asks for a name as well: 

 

For the Apps Schema field, accept the default value, APPS. (This needs to match 

the concurrent-manager-server value, which is hard-coded.) For the other fields: 

• For an upgrade, enter values already established during installation of your 

earlier release. 

• For a fresh installation, enter the values you entered for concurrent-manager 

installation. 

5. In the Application TOP form, establish the GRC Controls TOP for the forms 

server — the highest-level directory for the storage of PCG files.  

• In the GRC Controls Application TOP Directory Location field, specify a 

directory that is the parent of the GRC Controls TOP. The Installer defaults 

to the forms-server-specific Oracle EBS TOP as the parent directory. 

• In the Custom Application Short Name field, specify a short name that is 

appended to the parent directory to form the GRC Controls TOP directory. 

By default the Installer selects XXLAAPPS as the short name. 
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The application short name for the forms server must be the same as the concur-

rent manager server’s. If you’re upgrading, enter the parent directory established 

during installation of the earlier release. For a fresh installation, you can select a 

parent directory other than the default: click on the Choose button and, in a Select 

a Folder window, navigate to the directory you want. If you name a nonexistent 

directory, the Installer creates it. Click Restore Default to return to the default 

directory. 

No matter what case you use to enter values, the Installer saves the short name 

as all uppercase (and adds the uppercase _TOP to create a top shell variable), and 

the directory location as all lowercase. (However, for a reinstallation, the 

Installer does not change the case of an existing application TOP.) 

The forms-server Installer, like its concurrent-manager-server counterpart, 

presents a warning if you select an application short name that is already in use 

and it presents the same response options: 

• Click Enter Again to return to the Application TOP form and set a new value. 

• Click Continue to accept the duplicate application short name. This choice 

is correct if you’re upgrading PCG. For a fresh installation, however, this 

option causes PCG and another application to share the name, with the risk 

that files for one application or the other might be overwritten. 

• Click Abort to abandon the PCG installation. 

6. In the Environment form, specify paths to files that contain environment 

variables for the Oracle EBS shell (the first two prompts) and for forms paths 

(the APPSORA prompt). Accept the defaults, or click a Choose button and, in a 

Select a Folder window, navigate to a directory you want. If you enter the name 

of a nonexistent directory, the Installer creates that directory. To return to the 

default directory, click the Restore Default button. In any case select values that 

are appropriate for the forms server. 

7. When you complete the Environment form, the forms server Installer presents a 

CUSTOM.pll form: 
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If you select Yes, the Installer backs up your existing CUSTOM.pll (the backup 

has a timestamp appended to the .pll file extension). The installer then overwrites 

the original with a version that contains links to a file called LACUSTOM.pll. 

Forms server installation requires that the CUSTOM.pll file contain these links.  

If your original CUSTOM.pll contained any customization, and you select Yes 

here, then to retain your customizations you would need to copy them manually 

from the backup file to the new version of CUSTOM.pll. However, source code 

added to CUSTOM.pll by customers not specific to PCG, although known to 

work, is not supported under any circumstance. 

If you select No, the installer retains your existing CUSTOM.pll. In this case, you 

need to edit the file to insert links to LACUSTOM.pll (see below). However, Oracle 

does not support these edits to the CUSTOM.pll file.  

In effect, selecting Yes in this CUSTOM.pll form and then performing no edits to the 

resulting PCG-specific version of CUSTOM.pll is the only option Oracle supports.  

8. In the Input Summary form, review the selections you have made. If you 

determine that any entry is inappropriate, you can click on the Previous button 

until you reach the form in which you selected the entry, and change it. (The 

Installer retains any entries you don’t change, even if you pass by them as you 

return to an earlier step in the installation process.)  

9. When you’re satisfied with the selections you have made in preceding forms, 

click on the Install button in the Input Summary form to complete the forms 

server installation. 

The Installer displays error messages (if any are warranted) upon completing the 

installation of each PCG application, and displays an overall status upon completing 

the installation of all products. If the overall status is Success, the installation has 

finished with no errors.  

If errors occur, they or the overall status may be classified as Warning, Nonfatal, or 

Fatal, depending on severity. The Installer recovers (restores the system to its state 

prior to the installation) for Fatal errors, but not for Warning or Nonfatal errors. 

For details about errors and the installation process, navigate to the directory from 

which the Installer ran and review two log files: LAFRM_LOG_timestamp.log and 

LAFRM_ERROR_timestamp.log. Timestamp is the date and time the Installer ran. 

CUSTOM.pll Modifications 

If you chose (in step 7) not to overwrite your CUSTOM.pll file, edit the CUSTOM.pll 

file. However, Oracle does not support these edits. (If you selected Yes in step 7, 

ignore this section and skip ahead to “Configure the Remote Compilation.”) 

1. In place of the existing code for Procedure Event(event_name varchar2), 

substitute the following: 

PROCEDURE event(event_name varchar2) is  

  form_name varchar2(30) := name_in('system.current_form');  

  block_name varchar2(30) := name_in('system.cursor_block');   

  field_name varchar2(30) := name_in('system.current_item'); 

  function_name varchar2(30); 

  parameters  varchar2(2000); 
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begin  

  if (event_name = 'ZOOM') then    

    la_enhncmtmgr_pkg.la_zooms(form_name,block_name,  

        function_name,parameters); 

      if function_name is not NULL 

      then 

        if parameters is null then 

          fnd_function.execute(function_name,'Y','N'); 

        elsif 'ZOOMSPECIAL' = substr(parameters,1,11) then  

          lacustom.event('ZOOMSPECIAL'); -----new code 081903 

      else 

        parameters := lazoom.zoom_event(parameters); 

        fnd_function.execute(function_name,'Y','N',parameters); 

      end if; 

  end if; 

-----------------------------------WNF 

  elsif (event_name='WHEN-NEW-FORM-INSTANCE') then 

 lacustom.event('WNF'); 

---------------------------WNB 

  elsif (event_name = 'WHEN-NEW-BLOCK-INSTANCE') then 

 lacustom.event('WNB'); 

------------------------------WNI 

  elsif (event_name = 'WHEN-NEW-ITEM-INSTANCE') then 

 lacustom.event('WNI'); 

------------------------WNR 

  elsif (event_name = 'WHEN-NEW-RECORD-INSTANCE') then  

 lacustom.event('WNR'); 

------------------------WNV 

  elsif (event_name = 'WHEN-VALIDATE-RECORD') then 

 lacustom.event('WVR'); 

------------------------ 

  elsif (substr(event_name,1,7) = 'SPECIAL') then 

 execute_menu(event_name); 

-------------------------------------------- 

   else lacustom.event(event_name);   --put other events here 

   end if; 

end event; 

2. In place of the code for Function zoom_available, substitute the following: 

FUNCTION zoom_available return boolean is 

    v_enabled varchar2(20); 

  begin   --x 

    v_enabled := lazoom.zoom_enabled; 

    IF v_enabled = 'TRUE' THEN  

      return TRUE;  

    else  

      return FALSE;  

    end if;  

  RETURN NULL;  

  end zoom_available; 

3. Attach the following libraries. (Remove the path when attaching the libraries.) 

• LACUSTOM.pll 

• LABRSQL.pll 

4. Compile the file and ensure there are no compilation errors. 
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Servlet Mode 

If the forms server runs in servlet mode, you must edit a file to enable Oracle to recog-

nize the GRC Controls TOP you selected during installation (see step 5 on page 15).  

To determine whether the forms server runs in servlet mode, identify the file repre-

sented by the Oracle environment variable $FORMS60_WEB_CONFIG_FILE. Open that 

file and search for its serverURL entry. If that entry is set to the value /forms/formservlet, 

the forms server runs in servlet mode. If the entry is blank, the forms server runs in 

socket mode, in which case you need not complete the following procedure. 

If the forms server runs in servlet mode: 

1. Using a text editor, open a file called formservlet.ini. The file is located either in 

$APACHE_TOP/Jserv/etc or in $IAS_ORACLE_HOME/Apache/Jserv/etc. 

2. In the formservlet.ini file, look for a block of entries bounded by the lines #Begin 

Customization and #End Customization. 

3. Add the following entry anywhere between the Begin and End Customization lines:  

XXLAAPPS_TOP=$APPL_TOP/xxlaapps/12.2.9 

Note, however, that the value XXLAAPPS is correct in this entry only if you have 

accepted the default application short name during installation. If not, then in 

each of the two places that the value XXLAAPPS appears in this entry (whether in 

upper or lower case), substitute the short name you created in step 5 on page 15. 

4. Save and close the file. 

Configure the Remote Compilation 
To finish the installation, you must configure a remote compilation feature, which 

makes libraries resident on the concurrent server available to the forms server. 

1. Log on to the concurrent manager server. 

2. Source out the Oracle EBS shell environment.  

3. Navigate to the $XXLAAPPS_TOP/bin directory (a subdirectory, called bin, of the 

GRC Controls TOP directory, which you established in step 5 of the concurrent 

manager server installation process).  

4. Grant the execute permission on a file called laconfig.sh: 

$ chmod +x laconfig.sh 

5. Run the laconfig.sh file: 

$ laconfig.sh  

Running the laconfig.sh file produces a series of command-line prompts. Respond 

to them as follows: 

1. You’re prompted to enter the GRC Controls application short name. If that 

name is other than XXLAAPPS, type it and press the Enter key. (Case is not 

significant.) If the short name is XXLAAPPS, simply press the enter key in 

response to the prompt. 

2. A prompt displays a path to a Java executable; you must confirm that this is the 

path to the Java executable used by Oracle EBS. It is, if you sourced out the 
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Oracle EBSshell environment before running the laconfig.sh file (no matter how 

many Java executables reside on your system). It may not be, if you did not 

source out the Oracle EBS shell environment and have more than one Java 

executable on your system. 

If the prompt displays the path to the Oracle EBS Java executable, type Y (for yes) 

and press the Enter key. If not, type N (for no), press the Enter key, then type the 

full path to the Java executable used by Oracle EBS and press the Enter key again. 

3. A prompt displays a path for a file that sets the Oracle EBS environment; you 

must confirm that it is correct. The default value is taken from the shell as 

$APPL_TOP/$APPLFENV, and this selection is always safe; to accept it, press Y 

(for yes) and press the Enter key. But what’s really at issue is the file that sets 

the GRC Controls TOP, which is a subsidiary file of $APPLFENV. You may wish 

to specify it instead; if so, type N (for no), then type the full path to the appro-

priate file and press the Enter key. 

4. The following prompt appears: 

Choose your node configuration from below: 

1.  All servers (CM/Forms) share the same application top 

    directory 

2.  Forms server has different application top file system  

    than concurrent managers  

3.  Exit Program 

Enter 1 if all database, forms, and concurrent servers exist under a single applica-

tion TOP, or 2 if each exists under its own application TOP (regardless of whether 

they reside on a single machine or more than one).  

5. You’re prompted to enter the number of distinct application TOPs used by forms 

servers. Type the number and press the Enter key. 

6. For each of the application TOPs you include in the count in step 5, you’re 

prompted to select a method for transferring files to the application TOP direc-

tory. Enter one of the following and press the Enter key: 

• 1 for secured shell (ssh) 

• 2 for remote execution (rexec) 

• 3 for telnet 

• 4 for local file system (copy) 

• 5 for manual 

7. For each application TOP, you’re prompted for supporting information if you 

have selected any of the first four access methods. (Method 5, manual, requires 

no supporting information.) 

• Server host name if you selected option 1, 2, 3, or 4 

• Full path to PCG binary files if you selected option 1, 2, 3, or 4 

• User ID if you selected option 1, 2, or 3 

• Password if you selected option 3 

Entries are validated, so that if you enter incorrect supporting information 

you’re prompted to try again. 



 

 Install Preventive Controls Governor 21 

When you finish executing the laconfig.sh file, verify that the following files exist: 

• Concurrent manager server (under $XXLAAPPS_TOP/bin): LAGENLIB.prog, 

LAMIGRATE.prog, LAIMPORT.prog, and GRC_BIP_RPT_UPLOAD.prog 

• Forms server: LAFORMSGEN.prog 

Finally, if you want to enable migration (the ability to port PCG configurations from 

one instance to another) with password security: 

1. Navigate to \\System Administrator Responsibility\Profile\System. 

2. Query for the LAAPPS: Enable Migration Security profile option. 

3. Set the value to Yes at site level. (This can be controlled further at the 

responsibility and user levels.) 

Bounce the Servers 
When you finish configuring the remote compilation feature, bounce both the form 

server and the concurrent manager server. 

Postinstallation Tasks 
Once the installation is complete, you must perform additional tasks. Some are 

required in any case, and others only if you run particular versions of Oracle E-

Business Suite or if other special circumstances apply. 

Compile SQL Rules 

From within PCG, you must run an option to compile SQL rules: 

1. Log on to the GRC Controls responsibility in Oracle E-Business Suite. In that 

responsibility, select Form Rules. 

2. A GRC Controls–Oracle Rules form opens. Select its Form Rules tab. 

3. Click on Tools in the menu bar, and then Oracle Form Rules Compile All 

Active SQL Rules in the Tools menu. 

4. A pop-up message informs you of an ID number for the concurrent request that 

executes the SQL rule compilation. Make a note of the number, and then click 

on the OK button to close the message. 

5. Optionally, verify that the request has been completed successfully.  

a Click on View in the menu bar, then on Requests in the View menu.  

b A Find Requests form opens. In it, click on the Specific Request radio 

button. Type the ID number of your concurrent request in the Request ID 

field, and click on the Find button. 

c A Requests form opens. In the row displaying information about your 

request, ensure that the entry in the Phase field is Completed (you may need 

to click the Refresh Data button), and the entry in the Status field is Normal. 

d Close the Requests form: click on the × symbol in its upper right corner. 
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Associate GRC Controls Functions 

Use a Mass Associate Function feature to make PCG functions available to users: 

• For a PCG upgrade, activate all PCG functions. Submit a request to exclude each 

function from all menus, then submit a request to include each function in all menus.  

• For a fresh PCG installation, associate a GRC Controls Activate Responsibilities func-

tion with responsibilities or menus from which administrators open the Oracle Users 

form. (This activates an Activate Responsibilities menu option. PCG inserts it in the 

Actions menu of the Users form to support Application Access Controls Governor.) 

To complete these tasks: 

1. In the GRC Controls–Oracle Rules form, ensure that either the Form Rules or 

Flow Rules tab is selected. 

2. Click on GRC Controls Utilities in the menu bar, and then on Mass Associate 

Function in the Utilities menu. A Mass Associate Function form appears. 

3. Click on the Menu or Responsibility radio button (to determine which type of 

item you will associate with the function). 

4. In the Function Name field, select one of the functions available to PCG — for 

example, GRC Controls Activate Responsibilities. 

5. Choose the menus or responsibilities you want to associate with the function 

you’ve selected. By default, the Include radio button is selected for all items in 

the Associate Function list. You can: 

• Exclude or include all menus or responsibilities. Click on the Select All 

check box so that it changes to read “Deselect All.” Then click on it again; 

this selects all the Exclude radio buttons and clears all the Include radio but-

tons, and it changes the check box label back to “Select All.” Click on it once 

again; this selects all the Include radio buttons and clears all the Exclude 

radio buttons, and it changes the check box label back to “Deselect All.” 

• Deselect individual included menus or responsibilities by clicking on the 

Exclude radio button for each. 

• Select individual excluded menus or responsibilities by clicking on the 

Include radio button for each. 

6. Click the Submit button. Users with access to the newly associated menus or 

assigned the newly associated responsibilities then have access to the function. 

Change Control Wizard 

In Preventive Controls Governor, a Change Control Wizard enables users to write 

rules that impose change control on Oracle E-Business Suite fields. In order for the 

Wizard to be used, you must run a Create Audit Rules Objects option: 

1. In the GRC Controls–Oracle Rules form, ensure the Audit Rules tab is selected. 

2. Click on GRC Controls Utilities in the menu bar, and then Create Audit Rules 

Objects in the GRC Controls Utilities menu. 

3. A pop-up message indicates that a concurrent request has been run. Make a note 

of its number, and then click on the OK button to close the message. 

4. Optionally, verify completion of the request. (See step 5 on page 21.) 
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Source the PCG Environment 

Edit an .xml file known as a “context file” in order for Oracle EBS to source the 

PCG environment. (Sourcing is done through the use of a .env file, for which the 

context file serves as a template.) 

1. Using an xml editor, open the file $APPL_TOP/admin/sid_host.xml. In this file 

name, replace sid with the system identifier for the APPS database and host with 

the host name of the machine on which the APPS database resides.  

2. In the file, search for the value ZX_TOP.  

3. Add the following line immediately beneath the ZX_TOP row.  

<XXLAAPPS_TOP oa_var="s_xxlaappstop" oa_type="PROD_TOP" 

oa_enabled="FALSE">$APPL_TOP/xxlaapps/12.2.9</XXLAAPPS_TOP> 

Note the following: 

• The value XXLAAPPS is correct in this line only if you accepted the default 

application short name during installation. If not, then in each of the four 

places that the value XXLAAPPS appears in this line (whether in upper or 

lower case), substitute the short name you created in step 5 on page 12.  

• In place of the value $APPL_TOP, supply the actual full path to the Oracle 

EBS TOP directory.  

4. Save the file.  

Audit Rules 

Audit Rules affords database auditing not only to users, but also to Change Control 

in PCG. To prepare auditing functionality, complete the following tasks.  

First, add the LACSVREPORT style to the printer you will use for Audit Rules: 

1. In the System Administrator responsibility, select Install, then Printer, then Register.  

2. A Printers form appears. In its Printer field, select the printer you wish to use 

with Audit Rules. Note the value that appears in the Type field when you select 

the printer, and then click on the Printer Types button. 

3. A Printer Types form appears. In its Type field, query for the Type you noted in 

step 2. (Press the F11 key; enter the Type value in the Type field; press Ctrl+F11.) 

4. In the Style list of values, select LACSVREPORT; the software automatically 

supplies an associated value under Driver Name.  

 
5. Click on File in the menu bar, then on Save in the File menu. 
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Second, schedule a concurrent-request program called Audit: Dequeue Process to be 

run periodically. This enables reports for the Audit Rules and Preventive Controls 

Governor (change control) to display current data. So the period at which you 

schedule the running of this concurrent program depends upon the frequency with 

which you expect to run these reports. To schedule the program: 

1. Switch to the GRC Controls responsibility. (Use the Switch Responsibility icon, 

sixth from the left on the tool bar.) 

2. In the Navigator, select Requests: Run under the Administration heading. 

3. In the Submit a New Request form, select Single Request and click the OK 

button.  

4. In the Submit Request form, select Audit: Dequeue Process in the Name field 

(the program takes no parameters). Then click on the Schedule button. 

5. In the Schedule form, select the Periodically radio button. In related fields, select 

values appropriate for the schedule you want to set. Click on the OK button. 

6. In the Submit Request form, click on the Submit button.  

Different Hosts 

If the database server and concurrent manager server are on different hosts, make 

the following changes to the Tkprof script (LATKPROF.prog), which is located in the 

PCG binary directory on the concurrent manager server. (The changed lines are 

shown in boldface.) The value <db_ login> is the user name to log on to the 

database server, and the value <db_ hostname> is the database server name.  

#!/bin/sh 

oracle_login=$1 

tempfile=$$latkprof.txt 

temptrc=$$latkprof.trc 

echo Temp file $tempfile 

echo tkprof directory "$5" 

pwd 

tkfiles=`ssh <db_login>@<db_hostname> ls $5` 

for i in $tkfiles 

do 

echo processing $i 

scp <db_login>@<db_hostname>:$i /tmp/$temptrc 

tkprof /tmp/$temptrc /tmp/$tempfile explain=$1 

cat /tmp/$tempfile 

rm /tmp/$tempfile 

rm /tmp/$temptrc 

done 

If you have multiple APPS schemas, the LA_ENHNCMTMGR_PKG must be created as 

a synonym under each schema. To perform this operation, run the following 

command: 

create synonym LA_ENHNCMTMGR_PKG for apps.LA_ENHNCMTMGR_PKG 

If this is not set, the following error message appears when a user attempts to log on 

to a read-only or MRC (multiple reporting currency) responsibility: 

la_enhncmtmgr_pkg not declared 
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Unwanted Characters 

If, as PCG is used, unwanted characters appear in forms in any of the twelve lan-

guages PCG can display, complete these steps to remove them: 

1. Navigate to $ORACLE_HOME/forms60/admin/resources. 

2. From there, navigate to the directory for the language in which the unwanted 

characters appear. 

3. Back up the file fmrweb.res. 

4. Copy the file fmrweb_utf8.res file as fmrweb.res. 

5. Stop and restart the forms server. 

Read-Only APPS Schema 

PCG requires access to various database objects on the APPS schema. If you don’t 

allow custom objects to refer directly to the APPS schema, you can create a custom 

APPS schema with read-only permissions. (It’s customarily referred to as the 

APPSREADONLY schema.) To do so, run the following scripts, which the Installer has 

placed on your system. 

• laa_rd_custom_tab_grants_to_apps.sql: This script is executed from XXLAAPPS. 

It contains the grants  having “WITH GRANT OPTION” for XXLAAPPS custom objects. 

• laa_rd_apps_views_syn_to_schema.sql: This script is executed from APPS. It 

gives grants and creates synonyms in the destination schema for the identified 

Oracle APPS tables. 

• laa_rd_apps_packages_to_schema.sql: This script is executed from APPS. It 

gives grants and creates synonyms  in destination schema for the identified 

Oracle APPS packages. 

• laa_rd_custom_packages_to_schema.sql: This script is executed from APPS. It 

gives grants and creates synonyms in the destination schema for custom pack-

ages for the GRCC Suite. 

• laa_rd_custom_tab_to_schema.sql: This script is executed from APPS. It gives 

grants and creates synonyms in destination schema for the custom tables for the 

GRCC Suite. This script need not be run if the destination schema is XXLAAPPS. 

• laa_rd_custom_views_to_schema.sql: This is script is executed from APPS. It 

gives grants and creates synonyms  in the destination schema for the custom 

views for the GRCC Suite. 

• laa_rd_cm_apps_tables_grants.sql: This script is executed from APPS. It gives 

SELECT grants to the destination schema for Oracle APPS tables accessed by 

GRCC control monitors. 

• laa_rd_cm_apps_tab_synonyms.sql: This script is executed from the destination 

schema. It creates synonyms for Oracle APPS tables accessed by GRCC control 

monitors in the destination schema. 
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3 

Validation 

As a part of the installation process, the Installer programs complete several 

“behind-the-scenes” tasks. Open Oracle E-Business Suite forms to confirm that 

these tasks have been completed.  

As you perform these validation steps, you may be instructed to “query for” a value. 

If so, press the F11 key, type the specified value in a specified field, and then press 

Ctrl+F11. 

1. Log on to the System Administrator responsibility in Oracle E-Business Suite. 

2. Select Application, then Register. 

3. In the Application field, query for GRC Controls Custom. The form should 

contain the following values: 

 

4. Switch to the Application Developer responsibility.  

• Select File in the menu bar. 

• Select Switch Responsibility in the File menu.  

• A Responsibilities list appears; in it, select Application Developer.  

5. In the Application Developer Navigator, double-click on Application, then 

Form.  



 

28 Oracle Preventive Controls Governor Installation Guide 

6. In the Form field, query on LABIZ. The form should contain the following 

values: 

 

7. Switch back to the System Administrator responsibility.  

• Select File in the menu bar. 

• Select Switch Responsibility in the File menu.  

• A Responsibilities list appears; in it, select System Administrator.  

8. In the System Administrator Navigator, select Security, then Responsibility, 

then Request.  

9. In the Request Groups form, query for GRC Controls Request Group. The form 

should contain the following values: 
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10. Still in the System Administrator responsibility, select Application, then Menu 

in the Navigator. In the Menus form, query for LAAR_NAVIGATE and confirm 

the values shown in the following illustration.  

 

11. In the System Administrator Navigator, select Security, then Responsibility, 

then Define. In the Responsibilities form, query for GRC Controls. (This is the 

responsibility you would assign to Oracle E-Business Suite users so that they 

can use PCG applications.) 
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Switch to the GRC Controls responsibility and, in its Navigator, select Preventive 

Controls Governor, and then Form Rules. Then do the following: 

1. Select Tools in the menu bar, then Oracle Rules Configurations in the Tools menu. 

2. An Oracle Rules Configurations form appears. Confirm that a value is displayed 

in the UTL Path field: 

 

3. The UTL Path field value should match the name of one of the directories set 

for UTL PATH in your environment. To confirm that, check the directory names in 

the <DB_NAME>_utlfiledir.txt file, which is available in the <ORACLE_HOME>/dbs 

directory. 

Finally, confirm that appropriate values have been set for GRC Controls libraries: 

1. With Form Rules open, click on GRC Controls Utilities in the menu bar, then 

on Oracle Rules Library in the GRC Controls Utilities menu.  

2. With a GRC Controls Libraries form open, click on Tools in the menu bar, then 

on Value Sets in the Tools menu. 

3. In the Name field of the Find Value Set form, enter the value LA% and click on 

the Find button. 

4. Select (one at a time) the LAAC_CATEGORY, LAAR_LIBRARY_MODULES, and 

LAAR_LIBRARY_THEME entries. For each, confirm that a Segment Values form 

displays ALL in the Values field for the Values, Effective tab. For example: 
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Installation History 

You can review information about the installation of files for your PCG 

implementation. To do so: 

1. Log on to the GRC Controls responsibility in Oracle E-Business Suite. 

2. In the Navigator, select Administration, and then Install History. The 

Installation History form appears: 

 

Each row provides information about the installation of a program element. 

Because there are several elements for each of the servers, a single installation 

fills multiple rows in the grid.  

3. To view a list of the files installed for a given element, click on the row for that 

element and then on the Installed Files button. The following form appears: 

 

Click on the Close button to clear this form.  
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4. Finally, to review information about all currently installed files (regardless of 

whether they were added in the most recent installation), click on the Current 

File Versions tab: 

 

5. To close the Installation History form, click on its × symbol. 
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